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Chapter 1. Getting Started 

Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your libraries, Technology 

files and any other data files before proceeding with the installation of the new version. The installer 

should not overwrite any of your own named files, but it can re-install new copies of our standard 

data files so if you have changed any of those files it is important to back them up first. If you are 

uncertain, check the time/date stamp on the file but in any case, make a back-up. 

Of course, backing up your data is important not only for the upgrade but also at regular intervals 

during design. 

Installation from a download link 

A download link for the installation of Easy-PC would have been provided to you by email. Click on 

the link to download the executable named EasyPC.exe. This is the whole installation set and should 

be saved and backed up for future use. Any subsequent patches can be installed on top of this ‘base’ 

setup once installed. 

Using Windows Explorer, find the executable in your Downloads folder and double-click it. You’ll 

need to type (or copy/paste) the password provided to unpack this file. Once the unpack password 

has been successful, you will be allowed to continue with the installation. You will also need to have 

your customer ID number that will be in the download link and your 16-digit installation code to 

fully install the product. 

All other instructions should be followed until you click Finish to complete the installation. 

The installation is the same for new and existing users alike. Existing users with versions prior to this 

latest version can install the new software over an existing installation without deleting the old one 

first. 

Installation From CD 

CDs are no longer supplied; a download link would have been supplied to you by email. Under 

special circumstances, product on CD media can be purchased if you contact our sales office. 

Installing over existing Easy-PC software 

If you already have an earlier version of Easy-PC installed on your system and you wish to install the 

new version into the same folder as the earlier one, please note that you will then end up with both 

versions listed in the Windows Control Panel list of installed applications.  

If you don’t want the earlier one to be listed in the Control Panel, you will need to un-install that 

version before you install the new one. If you install the new software into the same folder as the old 

version then try to un-install the old one, you will find that the new software will not run as the un-

install will have removed many or all of the program files. 

If you wish to install and use the new version without removing the old one, you will need to install 

the new version into a different folder. The two versions will then operate independently and either 

can be un-installed without preventing the other from running. 

Uninstalling Existing Easy-PC Software 

Uninstalling will still remove shared registry entries, so it is recommended that a configuration file be 

saved first using the Configuration Files option from the Help menu and Support option. This will 

provide a restore point for any settings which may be lost. 



6   Easy-PC V27.0 Supplement 

Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data files (for 

example, Libraries, Technology files, etc). The default is always to use the common documents 

folder, C:\Users\Public\Documents\Easy-PC on Windows 10 or 11 if you are installing for All Users, 

or into your own Documents folder if installing for current user only. 

Running Easy-PC 27.0 

Once installed, an Easy-PC shortcut icon will appear on your desktop. 

This is also available on the Start panel in the Number One Systems 

folder. 

To start the program, double-click on the Easy-PC icon. 
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Chapter 2. New Features in Easy-PC V27 

 

SnapEDA Component Content Interface 

You can now access ready-made components from SnapEDA using a built-in interface. This enables 

you to search parts and download them directly into your Easy-PC designs and into your library. 

Accessing the Interface 

From the View menu, Dockable Bars> you can select the Component Search option. You can also 

select this option by right clicking on the Easy-PC framework and selecting Component Search from 

the menu. 

 

Prerequisites 

You must first have a SnapEDA account in order to download searched contents using this interface. 

Go to the SnapEDA web site (www.snapeda.com) to create yourself an account. You only need to do 

this once. Without an account, you can search and view content but not download it, you will need a 

login 

Running the Component Searcher 

Once you have created the SnapEDA account you can run the browser interface in Easy-PC, it will be 

displayed, ready for searching. 

Use the Log In button on the SnapEDA Interface to access your login details page for the SnapEDA 

web site.  
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You must have a login to download library content from this web site (see above). You should enter 

your details for the first time of use, then these will be remembered for subsequent use. Without the 

account and login, you can search and view content but not download it without the login.  

Running the Component Searcher 

Once logged in, type your required Part name into the Search field and press <Enter>: 

 

You will be presented with a list of found results, or a warning message if it doesn’t find any. 

Once items are found based on your search criteria, the results window will display an image of the 

manufacturer for each item, an image of the item plus icons for the Part Datasheet, Schematic 

Symbol and PCB Footprint if these are available as downloads in Easy-PC format. 

Be aware that some Parts may not have downloadable content available. However, once you have an 

account, you can request content creation directly from the SnapEDA web site. 

By selecting any of the orange icons to the right side of the results will display a quick preview of the 

item.  
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At this point, they have not been downloaded into the Easy-PC environment.  

If you select the Preview button, this will download the Part data and display it in the Preview 

windows in the Component Search Bar. 

 

Preview Windows 

Once the Preview button is selected, the Symbol and Footprint will be displayed in the Preview 

windows to the right side of the dialog. This indicates how they will appear in Easy-PC in your 

design.  

Once displayed, you can drag and drop the symbol into the design, or you can use the Add To Design 

button. 

Add To Library 

Use the Add To Library button to add the downloaded Component, Schematic Symbol and PCB 

Footprint into your own local Easy-PC library. Doing this means that you can also edit the Symbol 

or Footprint if you wish to refine it to suit your own needs. Remember also, these library items can be 

used on another design without having to download them again, whether you modify them or not. 

The downloaded library contents will be placed in a newly created library named 

DownloadedLibrary under your Library folder. 

Add to Design 

Use this button to add the downloaded Component into your design. This will place the Component at 

the end of your cursor in the design ready for placement plus the relevant symbol depending which 

editor you are currently using; Schematic or PCB. Another way to add the symbol is to select it in the 

preview window, then simply drag and drop it into your design. 
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Library Manager 

Ability to Float Library Manager 

The Library Manager dialog can now be made floating. This means, when editing a Component or 

Symbol, the dialog will still be visible. 

There are new check boxes to control this on the Settings menu, under Preferences and General.  

 

Two switches allow the Library Manager to be Floating and to Always be On Top (when floating). 

Styles Tool Improvements 

Improvements have been made to the way you select and apply style merging in the Styles Tool.  

 

The new functionality operates like this: if you select more than one style (using Ctrl+Click to select 

the desired rows), clicking Make Same will ask you which style name you want to keep: 

  

Selecting the style in the list will merge that style onto all the other ones you have selected once OK 

is pressed. This includes the ability to merge styles which are not equivalent, which you could not do 

previously.  

Previously, if you selected one style that has equivalent(s), it would merge all equivalent styles with 

that one. There was no control over the name used. 
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Edit Component - Name Ranges and ‘Display As’ feature in Multiply Named Pins 

There are changes to the Component editor and an extension to the definition of multiply named pins. 

This has been added to the Pin Assignments page of the Component editor. 

Name Ranges 

When creating multiply named pins in the Component editor, you can now use simple name ranges to 

specify lists of consecutive pin numbers. For example: 1,4,9-14,18,20-24 or 2+5-7+12. Previously, all 

pins had to be defined explicitly. 

Note that there is one special case, where your entire set of pin numbers is in a single range. In this 

case the range is treated as if you have used commas to specify ‘same net’: 1-9 

 

A comma will be used for externally connected pins, but if you want to specify internally connected 

pins instead, you will have to add the plus (+) sign as a suffix to the pin number string: 1-9+ 

Name Prefix (Display AS) 

You can also prefix a multiply named pin with a string that you want to display instead of the list of 

actual pin numbers. To do this, put your display string first in the Pad Number column, followed by 

the equals sign, then the rest of the multiple pin string. For example: Vdd=2,9-13,7,12 
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Library Reports 

From the Libraries option on the File menu, Report button, the Library Reports now have two 

additional options on the dialog. 

 

 

 

Show Last Edit Time will cause the last edit time of library item (if defined) to be included as a 

column in the report.  

Only include items saved on or after this date which means the report will only include items saved 

on or after the date specified in the date box below it. 
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Component Bin 

New Selection Options 

From the context menu in the Component Bin, there are new commands to assist you with selection, 

sorting and filtering, dragging the desired set of Components out of the bin and for placement around 

the board outline: 

• Sort and Filter 

• Select ‘Same’ Commands 

• Place Around Board From Bin 

 

Sort and Filter 

When you right-click on the Component Bin list, the command, Sort and Filter is available.  
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This invokes a new dialog from where you can specify parameters for sorting and filtering the 

Components shown in the bin. 

 

Sorting and Filtering options allow you to sort in your preferred order based on Component (name), 

Group, Name, Pin Count and Sheet (for a Schematic), in whatever order or combination is required. 

Both categories are slightly different; Sorting enables list of priority to be created in ascending or 

descending order using the Reverse button. The sort direction is indicated with the small arrow before 

the sort name. 

Filter enables you to remove or include items that you want to see in the list. 

When filtering options are enabled, the caption of the component bin shows [Filtered] to remind you 

that there are potentially more Components in the bin than are currently shown. 

 

Select ‘Same’ Commands 

When you right-click on the Component Bin list, there are new commands available to Select All 

Same xxx to assist you when dragging the desired set of Components out onto the design: 

• Select All Same Component 
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• Select All Same Group 

• Select All Same Pins 

• Select All Same Symbol 

 

These options look at the item(s) already selected in the Bin, and go through the other items in the Bin 

to select the ones that match on the chosen criteria. 

For example, select one simple resistor, right click and Select All Same Pins, and all two-pin 

components will become selected. 

Select Browse 

When working with the Component Bin, you can select items in the bin based on criteria chosen 

using the new option, Select Browse.  

 

This option is available from the context menu when right clicking in the list. 

 



16   Easy-PC V27.0 Supplement 

This displays a dialog from where you can make a selection based on: 

Connected to Net - One or more pins on a Component connected to specified Net. 

Connected to Net Class - One or more pins on a Component connected to specified Net Class. 

Component Name - Match by Component Name. 

Component Value - Match the Value, Select the Value Name from the drop down list or type a 

name in. Type in the Value or select it from the drop down list. 

Place Around Board From Bin 

From the Component Bin, there is a new command on the context menu called Place Around Board 

From Bin.  

 

This feature is already available with the existing Arrange Components dialog on the Tools menu 

but this allows you to make the placement directly from the Bin without further prompting or 

selection of options for placement. It will however use the settings on the main Arrange Component, 

including Component Stacking Above or Around the Board Area. 

The result will look like this: 
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Save Copy As 

There is a new command, Save Copy As on the File menu for Designs, Symbols, Technology Files, 

but not Projects. 

This command will prompt you with a standard file Save dialog, from where you specify the path 

where you want the copy of the current file to be saved. 

Note, if the file is currently part of a Project then it will be disconnected from that project, to prevent 

issues with the new and original design files being linked back to the same project. 

Project Improvements 

Project Name shows on Window Caption 

There is a new check box on the Settings menu under Preferences, General, named Project Name 

in Window Caption.  

 

If checked (the default setting), it will include the name of the project for any design files that belong 

to the project on the application framework caption: 

 

Sort Project Files 

Uses Project Menu 

The new option, Sort Project Files, is available on the Project menu of a Project. 
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Sort Other Files 

To sort Schematic sheets and Other Files, select a file in the Project tree view prior to using the 

option from the menu or context menu. 

 

  

The functionality on this dialog enable file list sorting to be performed manually using the Up and 

Down buttons and to promote a file to the Top or Bottom of the list. The list can also be sorted 

Alphabetically using the button available. 

This feature is also available by right-clicking on a selected Schematic in the tree view of a Project.  

 

Save Project Sheet Saves All Sheets 

From the Settings menu and Preferences option, General page, there is a new check box, Save all 

sheets when saving any sheet. If checked (the default setting is unchecked), when you save any 

Schematic that belongs to a Project, all Schematics in the Project will be saved. 
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Save Project Libraries 

There is a new command on the File menu named Save Project Libraries. This is very useful if you 

want to create a Project or ‘design’ based library set. 

When selected, this will create a new Component, PCB Symbol and Schematic Symbol library 

file, and copy all the library items to those libraries from every design in the project. 

If run from a Schematic or PCB design (if the design does not belong to a Project and its 

schematic/PCB ‘pair’ cannot be found), it will only create the Component library plus the appropriate 

symbol library (Schematic or PCB Footprint). For example, this option will not create Schematic .ssl 

library if running from a PCB design 

When selected, this option will prompt you to provide the name of the library set in which to save 

each library type and the location of the new library files. This will default to the same location as the 

Project itself. 

It will also ask if the path is to be added to libraries folders if it is not already in there. 

Close Other Sheets 

There is a new context menu item available on workbook tabs for a Project and Schematic sheets. 

This command allows you to close all the open sheets for a Project (when current document is the 

Project), or all sheets other than the current sheet (where the current document is a Schematic sheet). 
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Open File Location 

A new context menu item is available on a workbook tab for all documents. This opens the Windows 

file Explorer in the folder where that document resides. 

 

Clear Recent List from Add Component 

There is a new button on the Settings menu under Preferences and Interaction, use to Clear Recent 

List from the Add Component dialog. This will empty the list of remembered recent items (on the 

Add Component dialog) and start the list again. 

 

The Add Component, Recent list will be cleared: 
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Translate to PCB with additional options 

When choosing Translate To PCB from a Schematic or Project, you now have three options for 

creating your new PCB design: 

 

Based on a Technology File 

The first opens the existing dialog that allows you to choose a Technology File and Use the 

Component Bin. 

 

Based on an existing PCB Design 

The second allows you to find an existing PCB Design, from which it will copy the technology and 

related information as well as any board outlines, free copper, areas, text, etc. On selection of this 

option, you will select the PCB design from the Open dialog. 

This will have the same result as if the other design had been saved with File, Save Technology File, 

then the new design was created using this but without the need to create a technology file. 

Using New PCB Wizard 

The third option enables you to invoke the New PCB Wizard to create the new PCB. Here you can 

access a Technology file, choose various options for your layers, and define a basic board outline. 

 



22   Easy-PC V27.0 Supplement 

Colours – Force Everything On & Force All Value Positions 

Two new switches are available in the Colours dialog, under Settings & Highlights: 

• Force Everything on 

• Force All Value Positions on 

These switches work at a high level so they override all other switches in the Colours dialog. 

However, once used and set unchecked again, the previous colour settings are totally restored. 

 

Use the Force Everything check box to force everything on so that it is visible, true size and 

selectable. This will be everything except Values which has it own check box. 

Use the Force All Value Positions check box to force all Values in the design to be displayed. 

Note, Because the installer respects menu customisation, upgrade installations from some older 

versions may still show View, Display rather than View, Colours. 

Select All Gates 

If you are in a Schematic design, and have a single item selected that is all or part of a multi-gate 

Component, by right clicking the mouse, from the Select > sub-menu, there is a new command named 

Select All Gates. When selected, it will select all of the Gates on this Component. 
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Selecting it, will select all the gates on the same Component: 

 

Copy Shapes Between Different Design Types 

You can now copy a shape between two designs of different types (for example, between Schematic 

and PCB designs). The shape will be added using the styles and layers from shape defaults in the 

target design. 

For example, you might define a drawing blank as a Schematic Symbol, this can now be selected and 

copied into the Footprint editor where it can be saved for use (with a Component) in a PCB design. 

New Segment Mode for Shape/Track Editing 

New Segment Modes have been added for use when editing Shapes or Tracks. 

When editing a shape/track, from the context menu option Segment Mode>, you can now select 

some new modes: 

 

Fixed Angle – this segment mode can be used for adding single segments at a supplied angle. The 

default will be to add single segments at 45 degrees. Selecting this mode again from the menu returns 

it to the previous segment mode you were using. Use Enter Angle from the context menu to change 

to the required angle, you will then be able to add segments at this angle and at 45 degree rotation 

increments from that angle. 
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Select Snap to Angle Step from the context menu to snap to steps equal to the angle originally 

supplied. For example if the angle supplied was 15 degrees then you will be able to add segments at 

multiples of 15 degrees. 

Select Grid the Length from the context menu to grid the length of the angled segments being added 

using the current grid value. For example, if your working grid is set to 100, then the length of the 

segment in this mode will be 100. If this feature is not selected the line ends will snap orthogonally to 

the nearest grid point. 

Bitmap Properties Scale and Aspect Ratio 

The Bitmap Properties dialog for bitmaps has been updated. 

A scale box has been added which can be used to adjust the scale of the bitmap based on its 

original size. 

A check box to lock the Aspect Ratio has been added. 

Both Scale and also interactively dragging a corner to resize (see below) will maintain the 

Aspect Ratio if this button is checked on. 

 

Drag to Resize Bitmap 

Bitmaps can now be easily resized in the design by either dragging and edge or a corner. 

To move a corner, pick and drag it with nothing else selected in the design. 

The aspect ratio of a bitmap can be locked in Bitmap Properties so that when a corner is dragged the 

aspect ratio of the image is preserved. 

Previously bitmap sizes had to be changed in the Properties dialog. 
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Barcode Line Gap Additions 

The Narrow Gap and Wide Gap parameters can now be specified. These are used to add extra 

definition to the barcode format. 

 

The dialog has also been rearranged to be more logical in its layout and the Underlined check box 

removed for barcodes. 

   

Set Angular Precision in Units dialog 

On the Units dialog for a design, in addition to being able to set up two sets of units, you can now 

also specify the Angular Precision for display of angles in options such as Properties and Measure. 

Previously this was hard-wired to 1 decimal place for Measure and 2 decimal places for Properties. 
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On Properties, this shows as: 

 

Measure – Dual Units 

The Measure dialog/panel can now display lengths/areas in two different units.  

From the main Measure dialog, click on the Units: button (the one that shows the current units) to 

access the Measure Units dialog. 

 

This dialog now has an extra check box Show Two Units and a second pair of controls to let you set 

up the secondary units. 
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Once this is set up, any measurements you do will be displayed in both sets of units. The second unit 

set being shown in brackets ( ) on the Measure dialog: 

 

Design Rule Check 

DRC Within Current View 

There is an additional button on DRC dialog to allow checking within current view.  

 

Note that in common with some of the other settings (e.g. Inside named area) some of the checks still 

apply to the whole board, so ‘check where’ largely applies to the Spacing checks (as it did in previous 

versions). 
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Sort Report by Layer or Type 

The DRC report (either generated from the DRC dialog or later when run from the Output menu 

and Reports) will now be sorted into order.  

You can choose on the DRC dialog to sort by Layer or by Type. 

 

Show/Hide Accepted Errors 

A new button on the DRC dialog enables you to toggle between Showing or Hiding Accepted errors 

in the design. 

 

Nets – Max Vias 

This is a new check that can be used to ensure that certain nets do not exceed a required limit on the 

number of vias. The parameters are defined on a Net Class and can be edited through the Net Classes 

page of the Design Technology dialog under the Maximum Via Count option.  

 

The check box Max Vias under heading Nets on the DRC dialog is used to enable this check. 
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When checked, any net that has more vias than are allowed by its Net Class will have DRC error 

markers MV added at the position of the offending vias. Note that because there is no way to put vias 

on a net in a particular order, the error markers will be added to the excess vias in the order they 

happen to be defined in the design data. 

Design Rule Check – PCB Only nets 

There is a new DRC check for nets that are deemed pcb only. These are nets that are not connected to 

any component pin. Note that pins on PCB-only components are ignored when looking for valid 

component pins in the net. This check does not include free pads or vias. 

This check might be useful if you have free pads (as mounting holes) that are connected together but 

not to a component for example. 

The check box PCB Only under heading Nets on the DRC dialog is used to enable this check. 
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Max Stub Length 

There is a new DRC check that looks at the distance from the edge of a component pad to the next 

‘node’ (pad, via or junction), this is classed as a ‘stub’ route.  

 

The parameters are defined on a Net Class and can be edited through the Net Classes page of the 

Design Technology dialog under the Maximum Stub Length option.  

 

The check box Max Stub Length under heading Manufacturing on the DRC dialog is used to 

enable this check. 

 

New Report  - ‘Net Distances’  

Available from the Output menu, Report option, the new Net Distances report enables you to 

choose two or more nets from the PCB design and the program will calculate the minimum distance 

between each pair of nets. It will also indicate where that smallest distance occurs by use of optional 

error markers. 

Once run, the Report Distance Between Nets dialog is displayed: 
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Options allow you to select the Net Class or Net Name and to select the nets to be checked. 

The Add DRC Error Markers button can be ticked to cause the application to add a DRC error of 

type "ND" (Net Distance) for the location where each pair of nets comes closest together. Although 

these are not strictly errors, it does allow you to use the other facilities of the application (such as the 

Goto bar) to locate the places where the report indicates each pair of nets are closest together. 

Note: each time you run this report, all existing "ND" errors will be deleted from the design, 

regardless of which nets or net classes are chosen in each run. 

The report generated will look like this: 

 

New Report Headers 

File Folder Command 

An extra File Folder command to output just the last folder name of the file path has been added to 

the Settings menu, Preferences dialog under General and Report Headers. 



32   Easy-PC V27.0 Supplement 

 

Report Header – Date Commands now also show Time 

In Report Headers, where a date command is included (such as Creation Date, Last Saved or Date 

Written), this will now also show the time. 

Created:  23/06/2003 17:46:17 

Last Saved: 27/07/2023 14:32:12 

Plotting 

Auto Save Job File 

There is a new check box on the Plotting and Printing dialog, under Options, Auto Save Job File, 

which gives you the ability to disable/enable automatic saving of the job file on exit from the dialog. 

 

Plot Report Append/Overwrite 

From the Plotting and Printing dialog, when plots are generated, if the plot report already exists then 

you have the option of being prompted about overwriting the existing report or appending to it (or 

even cancelling opening the report). This is in addition to options already available to compose the 

plot report folder/file with things like a timestamp to get a separate report each time.  
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To enable this prompt, go to Plotting and Printing dialog, Options and select the Prompt if report 

already exists option. 

 

Pre Plot Checks 

When running plots from the Plotting and Printing dialog, the layers selected for each plot will be 

checked, and any layers that appear in more than one plot will be highlighted for you to confirm 

before carrying on with processing. This is to help avoid accidentally selecting the wrong layers when 

setting up the plots. 

For example, two top electrical plots: 

 

This will be warned to you like this: 

 

Note that this check will ignore any layers that are not single layers (e.g. [Through Hole]). It will also 

ignore ‘pads only’ plots as these will by their very nature involve outputting the same layer (e.g. Top) 

as it already used by a normal electrical plot. 

New & Modified Library Content 

Changes have been made to the standard library installation shipped with Easy-PC Version 27: 

Existing PCB outline templates have been removed from the discrete footprint library. 

PCB only drawing borders have been added and are included in a new library, Frames.cml. 

Drawing borders are already available for Schematics in the Schema library. 

A change has been made to the PCB footprint library sm.psl. All footprints have been edited 

so that they are all in the same, horizontal, orientation. Previously, some were vertically 

orientated. 


